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Your new Measurement Computing product comes with a fantastic extra –  

Management committed to your satisfaction! 
Thank you for choosing a Measurement Computing product—and congratulations! You own the finest, and you can now enjoy 
the protection of the most comprehensive warranties and unmatched phone tech support. It’s the embodiment of our mission: 
To provide data acquisition hardware and software that will save time and save money.  
Simple installations minimize the time between setting up your system and actually making measurements. We offer quick and 
simple access to outstanding live FREE technical support to help integrate MCC products into a DAQ system. 
Limited Lifetime Warranty: Most MCC products are covered by a limited lifetime warranty against defects in materials or 
workmanship for the life of the product, to the original purchaser, unless otherwise noted. Any products found to be defective in 
material or workmanship will be repaired, replaced with same or similar device, or refunded at MCC’s discretion. For specific 
information, please refer to the terms and conditions of sale. 
Harsh Environment Program: Any Measurement Computing product that is damaged due to misuse, or any reason, may be 
eligible for replacement with the same or similar device for 50% of the current list price. I/O boards face some harsh 
environments, some harsher than the boards are designed to withstand. Contact MCC to determine your product’s eligibility for 
this program. 
30 Day Money-Back Guarantee: Any Measurement Computing Corporation product may be returned within 30 days of 
purchase for a full refund of the price paid for the product being returned. If you are not satisfied, or chose the wrong product by 
mistake, you do not have to keep it. 
These warranties are in lieu of all other warranties, expressed or implied, including any implied warranty of merchantability or 
fitness for a particular application. The remedies provided herein are the buyer’s sole and exclusive remedies. Neither 
Measurement Computing Corporation, nor its employees shall be liable for any direct or indirect, special, incidental or 
consequential damage arising from the use of its products, even if Measurement Computing Corporation has been notified in 
advance of the possibility of such damages. 
 
Trademark and Copyright Information 
Measurement Computing Corporation, InstaCal, Universal Library, and the Measurement Computing logo are either trademarks 
or registered trademarks of Measurement Computing Corporation. Refer to the Copyrights & Trademarks section on 
mccdaq.com/legal for more information about Measurement Computing trademarks. Other product and company names 
mentioned herein are trademarks or trade names of their respective companies.  
© 2010-2012 Measurement Computing Corporation. All rights reserved. No part of this publication may be reproduced, stored in 
a retrieval system, or transmitted, in any form by any means, electronic, mechanical, by photocopying, recording, or otherwise 
without the prior written permission of Measurement Computing Corporation. 

Notice 
Measurement Computing Corporation does not authorize any Measurement Computing Corporation product for use 
in life support systems and/or devices without prior written consent from Measurement Computing Corporation. 
Life support devices/systems are devices or systems that, a) are intended for surgical implantation into the body, or 
b) support or sustain life and whose failure to perform can be reasonably expected to result in injury. Measurement 
Computing Corporation products are not designed with the components required, and are not subject to the testing 
required to ensure a level of reliability suitable for the treatment and diagnosis of people. 
 
 

http://www.mccdaq.com/legal.aspx�
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Preface 

About this User's Guide 

What you will learn from this user's guide 
This user's guide describes the device configuration, file management, and data file conversion features 
available in Measurement Computing DAQLog software software. 

Conventions in this user's guide 
For more information 
Text presented in a box signifies additional information and helpful hints related to the subject matter you are 
reading.  

Caution! Shaded caution statements present information to help you avoid injuring yourself and others, 
damaging your hardware, or losing your data.  

bold text Bold text is used for the names of objects on a screen, such as buttons, text boxes, and check boxes. 

italic text Italic text is used for the names of manuals and help topic titles, and to emphasize a word or phrase. 

Where to find more information 
Additional information about DAQLog software is available on our website at www.mccdaq.com. You can also 
contact Measurement Computing Corporation by phone, fax, or email with specific questions.  

 Phone: 508-946-5100 and follow the instructions for reaching Tech Support 
 Fax: 508-946-9500 to the attention of Tech Support 
 Email: techsupport@mccdaq.com

http://www.mccdaq.com/�
mailto:techsupport@measurementcomputing.com�
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Chapter 1 

Introducing DAQLog 
Use DAQLog to configure a Measurement Computing data logging device—such as a LGR-5320 Series logger— 
save configuration settings files and data files, and convert data files to viewable text files. 

System requirements 
You can install this DAQLog software package on a computer running one of these operating systems: 

 Windows XP with Service Pack 2 (SP2) 
 Windows Vista (32- and 64-bits*) 
 Windows 7(32- and 64-bits*) 

* The application is 32-bit, but software includes 64-bit drivers for accessing the device. 

Hardware requirements 
 Minimum screen resolution of 800 x 600 
 Computer with Pentium® 4 processor and 256 MB of RAM 
 A Microsoft-compatible mouse 
 A supported Measurement Computing logger, such as a LGR-5320 Series device 

Getting started 
Refer to the DAQLog Quick Start for instructions about how to install DAQLog, connect a 
LGR-5320 Series device to log data using DAQLog, and launch DAQLog. 

The DAQLog Quick Start is also available at www.mccdaq.com/PDFs/Manuals/QS-DAQLog.pdf.

http://www.mccdaq.com/PDFs/Manuals/QS-DAQLog.pdf�
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Chapter 2 

DAQLog user interface conventions 
The terms used for each section of the main DAQLog window are given in the following diagram. 

 

1 Menu bar—The File menu options save or deploy a logger settings file, locate the file selected in the Available Items 
pane, and convert a binary data file of logged data to a comma-separated format. The Help menu options open the 
DAQLog help file and display software version information. 

2 Toolbar—Refer to DAQLog toolbar for more information on each toolbar icon. 

3 Locations pane—Refer to Locations pane for more information. 

4 Available Items pane—Displays the contents of the selected logger device, SD drive, or folder. 

5 Tab area—Displays the current settings stored on the selected logger or the selected settings file. 
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DAQLog toolbar  
The toolbar contains the following options: 

New Settings File 

 

Creates a settings file and saves it to a logger, memory card, or settings folder. Refer to 
Creating a settings file on page 9. 

Delete 

 

Deletes the selected file in the Available Items pane. Refer to Deleting a settings or data file 
on page 27. 

Add SD Drive 

 
Adds an SD drive to DAQLog. Refer to Adding an SD drive location on page 25. 

Add Settings Folder 

 
Adds folders for storing settings files. Refer to Adding a settings folder location on page 26. 

Add Data Folder 

 

Adds folders for storing converted data files or folders containing binary data files. Refer to 
Adding a data folder location on page 27 for more information. 

Remove Location 

 

Removes the selected settings folder, data folder, or SD drive from DAQLog without 
affecting the folder itself.  
 Refer to Removing a logger from the DAQLog configuration on page 26 
 Refer to Removing an SD drive location on page 26. 
 Refer to Removing a settings folder location or data folder location on page 27. 

Save 

 

Saves the configuration settings made to the selected location. Refer to Saving your settings 
on page 21. 

Convert Data File 

 

Converts the selected data files to comma-separated text files and stores them in the 
folder specified by Output Location. Refer to Converting a data file on page 23. 

Deploy Settings File 

 

Copies a settings file to a connected logger, or, if no logger is connected, to the SD drive 
specified in the SD Drives pane. Refer to Deploying a settings file on page 21. 

Refresh Location 

 

Updates the contents of a data folder after the contents of the folder have changed (files are 
added to or removed from the DAQLog directory). 

Locate File on Drive 

 

Opens Windows Explorer to the directory path of a selected folder or file. 
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Locations pane 
The Locations pane displays logger devices, SD cards, and file storage folders.  

Logger Devices—Displays supported logger devices connected to the computer. Select a device to display 
device properties. You can view the current device configuration by selecting a Logger Devices location, then 
selecting Log Settings in the Available Items pane. 

SD Drives—Displays SD cards connected to your computer or inserted in a supported logger device. 

Logger Settings Folders—Displays folders that store logger settings files (.set).  

Data File Folders—Displays folders that store logger data files – either the raw binary files (.dat) or data files 
converted to text by DAQLog (.csv). 

Viewing device information and synchronizing a device 
To display the type of logger device and its serial number, firmware version, and FPGA version, select the 
device in the Logger Devices pane and select Device Info in the Available Items pane. 

 

The Onboard Clock textbox shows the time set on the internal clock on the device. Click Sync to set the 
onboard clock to the system time set on your computer. 

The onboard clock does not automatically compensate for daylight savings time.  
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Chapter 3 

Configuring a logger 
You can configure a logger with DAQLog in one of the following ways: 

 configure settings directly to the logger memory  
 create or modify a settings file, and load the file into logger memory 

Creating a settings file 
Complete the following steps to create a settings file to copy and load onto a logger: 

1. Select the location where you want to save the settings file from the Logger Settings Folder area. 
2. Click New Settings File on the toolbar.  

 

Modifying a settings file 
Complete the following steps to modify a settings file to load onto a logger: 

1. Open the folder in the Logger Settings Folders pane where the settings file is stored.  
2. Select the file and modify its settings on the Log Setup, Channels, Acquisition, and Events tabs.  

Selecting a logger to configure directly 
Complete the following steps to configure logger settings directly to device memory: 

1. Select the device in the Logger Devices pane. 
2. Select (Log Setting) in the Available Items pane and modify its settings on the Log Setup, Channels, 

Acquisition, and Events tabs. 
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Configuring logging settings 
Complete the following steps to configure logging settings: 

1. If you are creating a settings file, configure these settings in the Configuring Logging Session dialog box. 
If you are configuring a device directly or modifying a settings file, select the file in the Locations pane and 
configure these settings on the Log Setup, Channels, Acquisition and Events tabs: 

  

Settings Target list (selectable for new settings files only)—If you are creating a settings file, select the logger 
to configure with the file. Only settings supported by the selected logger are available. You can load a settings 
file to different types of loggers as long as the device supports the settings in the file. Refer to the LGR-5320 
Series User's Guide for features supported by each logger before loading a settings file onto a logger. 
Name textbox—Enter a name that briefly describes the logger settings file. The name you enter displays in the 
Available Items pane along with the actual file name. For example, if you enter LGR-5325 AI in the Name 
textbox, it displays In the Available Items pane as LGR-5325 AI(log_cfg.set). The name is also included 
in the header of the converted data file. 

 

Location—Displays on the Log Setup tab when configuring a logger directly or modifying a settings file. Lists 
the name of the folder or logger where the settings are stored. 
Overwrite oldest log when memory full checkbox—Select the checkbox to overwrite the oldest log files when 
the SD card memory is full. Clear the checkbox to stop logging when the SD card memory is full. 
Create hourly folders for new logs checkbox —Select the checkbox to create a new subfolder every hour to 
store new log files. Clear the checkbox to store new log files in the root of the Location folder. 
Autostart new log on completion of current log checkbox—Select the checkbox to automatically start new 
log session immediately after a log session ends, and store data from each session in a separate folder. Clear the 
checkbox to manually start a new log session by pressing START on the logger. 
Autostart new log upon device powerup checkbox—Select the check box to immediately start logging when 
you power on the logger. Clear the checkbox to manually start logging by pressing START on the logger. 
Set relay when logging post-trigger data checkbox—Select the checkbox to energize the relay when logger 
starts logging of post-trigger data. The relay remains energized until the log session ends. Clear the checkbox to 
eliminate the relay click, and to reduce wear on the relay. 

2. If you are creating a new settings file, click Next to open the Configuring Analog Inputs dialog box. 
If you are configuring a logger directly or modifying a settings file, click the Channels tab. 
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Analog input settings 
Use the analog input settings to configure the analog channels to log, the acquisition mode, the voltage range, and 
the units to use when converting analog data. 

 

Chan—List the number of each analog input channel. You cannot edit the numbers in this column. 

Log checkbox—Select the check box of each analog channel whose data you want to log. You can also use the Log 
checkbox at the top of the column to select or deselect all of the channels. 

Name textbox—Click this textbox to change the name of the corresponding logged channel. The name displays in 
the header of the converted data file.  

Mode list—Select SingleEnded or Differential for each logged analog channel. 

If you select ±30 Volts for a differential channel input, you must select ±30 Volts for both inputs of the channel pair. 
For example, if AI0 is set to Differential and to ±30 Volts, AI8 is also set to ±30 Volts. This is required by the input 
attenuation circuitry of the ±30 V range on the device. 

You can configure all analog channels for single-ended or differential mode using the Mode list in the column 
header. 

 

Refer to the screw terminal pinout in the Specifications chapter of the LGR-5320 Series User’s Guide for the 
differential and single-ended pinout of each logger. 

Range list—Select the voltage range for a logged channel.  

You can configure all analog channels for the same range using the Range list in the column header.  
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Units list—Select Counts, Volts, or mVolts for each logged channel. 

You can configure all analog channels for the same units using the Units list in the column header.  

 

If you are creating a new settings file, click Next to open the Configuring Counter Inputs dialog box. Otherwise, 
scroll down on the Channels tab to display the Counter Inputs settings. 

Counter input settings 
Counter inputs are grouped under the following categories: 
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Counter Setup  
Use the Counter Setup settings to select the counter channels to log and to configure each logged channel. 

Log checkbox—Select the checkbox for each counter channel you want to log. You can also select/deselect all 
counter channels using the Log checkbox in the column header. 

 

Name column—Click a textbox in the Name column to change the name of the corresponding logged channel. This 
channel name displays in the header of the converted data file. 

Mode list—Select one of the following counter modes from the Mode list. You can configure all counter channels to 
the same mode using the Mode list in the column header. 

 

 Counter—High-speed pulse and general counter operations.  
Select Totalize or Clear on Read from the Option list. Refer to Option list for more information.  
Select whether to ignore (No-Op), Gate, Latch, or Decrement the counter from the Index list. Refer to  
Index list for more information.  
The Tick Size list is disabled in this mode. 

 Up/Down Counter—Up/down counting that uses Phase A as the pulse source and Phase B as the direction. The 
counter changes direction depending on the state of Phase B.  
Select Totalize or Clear on Read from the Option list. Refer to Option list for more information.  
Select whether to ignore (No-Op) or Gate the counter from the Index list. Refer to Index list for more 
information. 
The Tick Size list is disabled in this mode.  
The Input (Phase B) Edge setting under Input Setup determines whether a high or low signal at phase B 
causes the counter to count up.  

 Encoder—Measure the system position (counts), velocity (counts per second), and direction of rotation of an 
encoder.  
Select 1X, 2X, or 4X from the Option list. Refer to Option list for more information.  
Select whether to ignore (No-Op), Clear, Gate, or Latch the counter from the Index list. Refer to Index list for 
more information. 
The Tick Size list is disabled in this mode.  

 Period—Measure the period of a signal on the Phase A input of a counter channel. You can measure x1, x10, 
x100 or x1000 periods.  
The Option list is disabled in this mode.  
Select whether to ignore (No-Op) or Gate the counter from the Index list. Refer to Index list for more 
information. 
Select 20 nsec, 200 nsec, 2 µsec, or 20 µsec from the Tick Size list. Refer to Tick Size list for more 
information.  
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 Pulse-Width—Measure the time from rising edge to falling edge or from falling edge to rising edge on the 
Phase A input of a counter channel.  
 
The Option list is disabled in this mode. 
Select whether to ignore (No-Op) or Gate the counter from the Index list. Refer to Index list for more 
information.  
Select 20 nsec, 200 nsec, 2 µsec, or 20 µsec from the Tick Size list. Refer to Tick Size list for more 
information.  

 Timing—Measure the time between rising or falling edge on the Phase A input and rising or falling edge of the 
index channel.  
The Option list is disabled in this mode. No-Op (ignore) is selected on the Index list.  
Select 20 nsec, 200 nsec, 2 µsec, or 20 µsec from the Tick Size list. Refer to Tick Size list for more 
information.  

Option list—Select one of the following counter options from the Option list: 

 Totalize—The counter counts rising edges or falling edges.  
 Clear On Read—The counter is cleared after each synchronous read. The counter value is latched and returned 

before it clears.  
 1X—Counts rising or falling edges on phase A (depending on the Phase A Edge setting).  
 2X—Counts rising edges and falling edges on phase A.  
 4X—Counts rising edges and falling edges on phase A and phase B.  
 1 Period—The measurement latches after one complete period is observed.  
 10 Periods—The measurement latches after 10 complete periods are observed.  
 100 Periods—The measurement latches after 100 complete periods are observed.  
 1000 Periods—The measurement latches after 1000 complete periods are observed.  

Index list—Select the counter index from the following settings: 

 No-Op—Ignore index signal.  
 Clear—Index signal clears the counter when counting up or to reload the modulo number when counting down 

(refer to Modulo N below). Enabled when the mode is set to Encoder.  
 Gate—Index signal gates the counter. By default, the counter is enabled when the Index signal is high. When 

the Index signal is low, the counter is disabled but holds the count value. Change the Index Edge to change gate 
polarity.  

 Decrement—Index signal decrements the counter.  
 Latch—Index signal latches the counter.  

Tick Size list—Select the counter tick size for period, pulse-width and timing measurements. The system clock of 
the field programmable gate array (FPGA) is 20 ns. 

 20 ns—Sets the counter channel tick size (timebase) to 20 ns.  
 200 ns—Sets the counter channel tick size to 200 ns.  
 2 µs—Sets the counter channel tick size to 2 µs  
 20 µs—Sets the counter channel tick size to 20 µs  

Reset checkbox—Select this checkbox to reset the counter before each scan. 

Clear the checkbox to continue counting without resetting the counter before each scan. You can configure all 
counter channels to the same setting using the Reset checkbox in the column header.  

 

Counter Size list—Select 16-bit or 32-bit. 

You can configure all counter channels to the same setting using the Counter Size list in the column header.  
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Modulo N—Enter the maximum count, or upper limit of the count. The modulo number can range from 1 to 
4,294,967,295 (0xFFFFFFFF hex), which is the maximum 32-bit counter value. 

When counting up, the counter rolls over to 0 when the Modulo N number is reached, and then continues counting 
up. When counting down, the counter rolls over to Modulo N whenever the count reaches 0, and then continues 
counting down. 

Modulo Mode—Select the counter behavior when the counter reaches the Modulo N value: 

 Rollover—The counter rolls over to a count of 0 and continues counting.  
 RangeLimit—When counting up, the counter counts up to Modulo N and stops. Counting resumes if the 

direction reverses or the counter is cleared. 
When counting down, the counter counts down to 0 and stops. Counting resumes if the direction reverses or the 
counter is cleared.  

 NoRecycle—The counter is disabled if a count overflow or underflow occurs. The counter is enabled again 
when a reset or load operation is performed.  

You can configure all counter channels to the same modulo mode using the Modulo Mode list in the column header.  

 

Format list—Select Decimal or Hexadecimal as the default format for converted counter data (you can select the 
format before you convert the data.) 

You can configure all counter channels to use the same number format using the Format list in the column header.  

 

Input Setup  
Use the Input Setup settings to select the edge/polarity and debounce settings for each logged channel: 

Input column— Shows the Phase A, Phase B and Index inputs for each channel. For LGR-5327 and LGR-5329 
devices, the channel names apply. For LGR-5325 devices, Phase A, Phase B and Index settings apply to CTRx, 
UPDNx and GATEx inputs respectively 

Edge list—Select Rising or Falling as the edge/polarity for the Phase A, Phase B and Index inputs for each logged 
counter channel 

You can set the edge of all logged counter channels using the Edge list in the column header. 

 

Debounce checkbox—Select the checkbox of each logged channel that you want to apply the debounce settings. 

You can select/deselect debounce on all logged counter channels using the Debounce checkbox in the column 
header. 

 
Debounce Mode list—Select one of the following debounce modes: 

 After-Stable—Select this mode to reject glitches and only changes state after a period of stability (the 
Debounce time).  
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Use this mode for electro-mechanical devices like encoders and mechanical switches to reject switch bounce 
and disturbances due to a vibrating encoder that is not otherwise moving. Select a time from the Debounce 
Time list that is short enough to accept the input pulse you want, but longer than the period of the disturbance.  

 Before-Stable— Select this mode to immediately change state. The state does not change again until the period 
of stability selected from the Debounce Time list elapses.  
Use this mode when the input signal has groups of glitches and each group is to be counted as one. The logger 
recognizes and counts the first glitch within a group, but rejects subsequent glitches within the group if the 
debounce time is set accordingly. Set the debounce time to encompass one entire group of glitches.  
You can select the same debounce mode for all logged counter channels using the Debounce Mode list in the 
column header.  

 

Debounce Time list—Select one of the debounce times that range from 0.5 µs (500 ns) to 25.5 ms. 

You can select the same debounce time on all logged counter channels using the Debounce Mode list in the column 
header. 

If you are creating a new settings file, click Next to open the Configuring Digital Inputs dialog box. 

Digital inputs 
Use the digital inputs settings to configure these digital options:   

 

Log checkbox—Select this checkbox to log digital input data. 

Name textbox—Click this textbox to change the descriptive name of the logged digital channel. This channel name 
displays in the header of the converted data file. 

Format list—Select one of the following number formats to use for converted digital data (you can select the format 
before you convert the data.) 

 Decimal—Data is converted to a decimal number.  
 Hexadecimal—Data is converted to a hexadecimal number.  
 Binary—Data is converted to a binary number.  
 Bitwise—Data is converted to a binary number, with each bit comma-separated.  

If you are creating a new settings file, click Next to open the Configuring Acquisition Startup, Timing, and 
Duration dialog box. 

Otherwise, click the Acquisition tab. 
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Acquisition startup, timing, and duration 
Use the acquisition startup, timing, and duration settings to configure trigger types and corresponding trigger 
settings. The settings that display vary depending on the selected trigger type. 

 

Scanning  
Pre-Trigger settings 

Configure the following pre-trigger settings: 

 Click the textbox in the Scan Duration column and enter the number of samples or time duration to acquire 
before a trigger occurs. Scan Duration and Scan Rate settings are disabled when the selected trigger type is 
Immediate Startup (no trigger). 

 Click the textbox in the Scan Rate column and enter the sample rate per channel to use when acquiring pre-
trigger data. Scan Rate settings are disabled when the selected trigger type is Immediate Startup (no trigger). 

Post-Trigger settings 

Configure the following post-trigger settings: 

 Click the textbox in the Scan Duration column and enter the number of samples or time duration to acquire 
after a trigger occurs.  

 Click the textbox in the Scan Rate column and enter the sample rate per channel to use when acquiring post-
trigger data.  

Units settings 

Select one of the following units from the list in the Scan Duration column to use for both Pre-Trigger and Post-
Trigger scan durations: 

 scans—Scan durations are based on the number of samples to acquire.  
 msec—Scan durations are in milliseconds.  
 s—Scan durations are in seconds.  
 min—Scan durations are in minutes.  
 hr—Scan durations are in hours.  

Select one of the following units from the list in the Scan Rate column to use for both Pre-Trigger and Post-
Trigger scan rates: 

 External—Scan rates are set by an external clock. Connect the PACER pin on the logger to an external clock, 
such as the pacer output of another logger. Selecting External enables the External Clock Edge option buttons, 
and changes the column header from Scan Rate to ExtClock Divisor. 

 Hz—Scan rates are in hertz.  
 MHz—Scan rates are in megahertz.  
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 kHz—Scan rate is in kilohertz. 
 msec –Scan rates are in milliseconds, 
 s—Scan rates are in seconds.  
 min-Scan rates are in minutes. 
 Hr-Scan rates are in hours. 

Output Internal Pacer checkbox—Select this checkbox to use the logger as the clock source for another device. 

External Clock Edge option buttons (only enabled when you select External from the Units row in the Scan Rate 
column)—Select either Rising or Falling as the clock edge of the external clock. 

Include Time-Stamps checkbox—Select this checkbox to include times stamps in logged data. Select one of the 
following time stamp formats from the list:  

 None—No time stamps are applied to logged data.  
 Seconds from Start (ss:ffffff)—Logs the number of seconds that the data was logged after data acquisition 

began; for example, 0.0006.  
 Time of Day (HH:mm:ss:fff)—Logs the time of day that the data was logged; for example, 10:08:19.035. 
 Date and Time-US (MM/dd/yyyy HH:mm:ss:fff)—Logs the date and time that the data was logged; for 

example, 04/05/2010 10:08:19.143.  
 Date and Time (yyyy-MM-dd HH:mm:ss:fff—Logs the date and time that the data was logged; for example, 

2010-04-05 10:08:19.984.  

Startup/Triggering  
Select the trigger type and configure the following trigger settings that vary based the selected trigger type. 

Type list—Select one of the following trigger types: 

 Immediate Startup—The scan begins immediately without any startup signal.  
 Digital Trigger—Use the Edge option buttons to select Rising or Falling as the edge used to trigger the 

acquisition. 
Select the Edge (vs Level) Sensitive checkbox to configure the trigger as edge sensitive. Clear the checkbox to 
configure the trigger as level sensitive. 

 

 Analog Trigger—Use the Edge/Level option buttons to select Edge Sensitive (trigger on a rising or falling 
edge) or Level Sensitive (trigger when the signal is above or below a threshold value).  
Use the Polarity option buttons to select Rising/Above Threshold or Falling/Below Threshold to trigger when 
the signal rises above or drops below a threshold value.  
Enter a value in the Threshold Level (Volts) textbox to configure the voltage level of the trigger.  
Enter a value in the Hysteresis Level (Volts) textbox to configure the range that a signal must pass through 
after causing a trigger before that signal can cause another trigger.  
Use the Range option buttons to select the analog trigger input range.  



DAQLog Software User's Guide Configuring a logger 

19 

 

 Multi-Channel Trigger—Configure the following logic and trigger type settings using multiple channels to 
trigger the acquisition:  
Logic option buttons—Select one of the following logic options:  

o And/All—Trigger the acquisition only when the conditions for all channels in the table are true.  
o Or/Any—Trigger the acquisition when one or more channel conditions in the table is true.  

Apply checkbox—Select the checkbox for each channel to include in the trigger conditions.  
Type list—Select a trigger type for each included channel (only trigger types supported by the connected logger 
are listed):  

o AboveThreshold—Triggers when the signal level rises above the threshold. The trigger stays valid 
until the signal level drops below the hysteresis range.  

o BelowThreshold—Triggers when the signal level drops below the threshold. The trigger stays valid 
until the signal level rises above the hysteresis range.  

o AboveThresholdWithLatch—Triggers when the signal level rises above the threshold. The trigger 
stays valid until the acquisition is complete and re-armed.  

o BelowThresholdWithLatch—Triggers when the signal level drops below the threshold. The trigger 
stays valid until the acquisition is complete and re-armed.  

o RisingEdge—Triggers when the signal level drops below the hysteresis range and then rises above the 
threshold. The trigger stays valid until the signal level drops below the hysteresis range again.  

o FallingEdge—Triggers when the signal level rises above the hysteresis range and then drops below the 
threshold. The trigger stays valid until the signal level rises above the hysteresis range again.  

o RisingEdgeWithLatch—Triggers when the signal level drops below the hysteresis range and then 
rises above the threshold. The trigger stays valid until the acquisition is complete, regardless of the 
signal level.  

o FallingEdgeWithLatch—Triggers when the signal level rises above the hysteresis range and then 
drops below the threshold. The trigger stays valid until the acquisition is complete, regardless of the 
signal level.  

Threshold textbox—For each included channel, enter the voltage level of the trigger.  
Hysteresis textbox—For each included channel, enter the range that a signal must pass through after causing a 
trigger before that signal can cause another trigger.  



DAQLog Software User's Guide Configuring a logger 

20 

 

 Digital Pattern (Mis)Match trigger—Configure the conditions and bit pattern for the digital pattern trigger:  
Condition option buttons—Select one of the following options:  

o Equal to Pattern (==)—Triggers when the binary numbers on a digital connector exactly match the 
defined bit pattern.  

o Differ from Pattern (<>)—Triggers when the binary numbers on a digital connector do not match the 
defined bit pattern.  

Pattern—Click each bit (0 to 15) to set its value and define the bit pattern. Each click cycles through settings of 
0, 1, and X (don't care – exclude that bit from the comparison).  
Click All to cycle through these settings for all of the bits  

 

If you are creating a new settings file, click Next to open the Configuring Event Recording dialog box. 

Event logs 
Configure the following event settings to configure the events to log: 

 

On Event Button Press checkbox— Select this checkbox to log an event each time you press the Event button on 
the logger device. 

On Scan Trigger checkbox—Select this checkbox to log an event on each trigger. 

On Digital Event checkbox—Select this checkbox to choose one of the following digital events: 

 State Change option button—Select this option button to log an event each time the digital inputs change state.  
 Pattern Match option button—Select this option button to log an event each time the digital inputs match the 

defined pattern. 1 indicates an active digital input, 0 indicates an inactive bit, and X denotes bits that are 
ignored.  
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Saving your settings 
If you are creating a new settings file, click Finish on the Configuring Event Recordings dialog box to save your 
settings. 

If you are modifying a settings file or configuring a device directly, click Save on the toolbar. 

 

 If you configured a device directly, the settings are loaded onto the device. 
 If you created or modified a settings file, you need to deploy the file to an SD card.  

Deploying a settings file 
Complete the following steps to deploy a settings file: 

1. Select a Logger Settings Folders location.  
2. Select a settings file from the Available Items pane and click Deploy Settings File on the toolbar. 

. 

If DAQLog detects more than one destination for the settings file, a Select Settings Target dialog box opens so you 
can select the target location for the settings file. If no destination is detected, the SD Drive Empty dialog box opens. 
Refer to Adding an SD drive location.  

A Settings Deployment—Successful dialog box opens after the file is deployed.  

The settings file displays in the Available Items pane when you select the location where you deployed the file. 

Click-and-drag deployment method 
Another way to deploy a settings file is to click-and-drag it from a Logger Settings Folders location to an SD 
Drives location or to a Logger Devices location. 

Loading a settings file and logging data 
You must disconnect the logger from the computer before you can load settings from the SD card. Refer to your 
hardware user's guide for more information. 

Complete the following steps to load a settings file from an SD card and log data with a LGR-5320 Series device: 

Caution! If you deployed a settings file directly to logger memory, DO NOT press Load on the device. Doing so 
replaces the settings in logger memory with the settings file stored on the SD card. 

If you deployed a settings file to an SD drive, make sure the SD card is inserted into the logger and press Load 
on the logger to update the logger settings. Configuration settings are stored in device memory whenever you 
press the Load button. 

Loading a settings file that is not supported by the logging device 
If the settings file you load contains settings that are not supported by the hardware, the logger LEDs blink in a 
defined error pattern. Refer to your hardware manual for specific information. 

1. Press START on the device to begin logging data. 
2. When the LOG LED turns off, remove the SD card from the card slot, and insert it into a card reader in your 

computer. 

The file containing the logged data is stored on the SD card. You can now convert it in order to view and analyze the 
data. 
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Chapter 4 

Converting a data file 
You must convert a DAQLog data files (.dat) to a comma-separated values text file (.csv) in order to display and 
analyze data. 

Configuring data file storage settings 
To configure how converted data files and file storage folders are named and organized, complete the following 
steps: 

1. Click the Data File Folders location where you want to store the converted data file.  
2. Configure the Store By settings in the Data File Storage Options section as appropriate:  

o Device Name checkbox—Select this checkbox to create a folder named for the logger; for example 
\LGR-5327.  

o Serial No checkbox—Select this checkbox to create a folder named with the logger serial number; for 
example \0000014AE021.  

3. Configure the Date Directories settings in the Data File Storage Options section as appropriate:  
o Separate Date Fields option button—Select this option button to create a folder named the date the 

log was started. The date is in a YYYY-MM-DD format.  
o Split into Subdirectories option button–Select this option button to create separate folders named for 

the year, month, and day that the data was logged; for example \2010\03\26\.  
o Keep The Same option button—Select this option button to create a folder named for the date the log 

started. The date is formatted as YYYYMMDD; for example \20100426\.  
4. Configure the Base Name settings in the Data File Storage Options section as appropriate:  

o Data textbox—Enter text to add to the beginning of the name of converted data files. For example, 
entering log changes 00006.dat to log00006.csv.  

o Event textbox—Enter text to add to the beginning of the name of converted event files. For example, 
entering evt changes 00006.evt to evt00006.csv.  

Refer to Output Files under Example for an example of the file names and directory structure based on your Store 
By settings. 
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Converting the file 
To convert a data file to a comma-separated values text file, complete the following steps: 

1. Select the location where the data file is stored.  
2. Select the file to convert from the Available Items pane.  
3. Select a destination for the converted file from the Location list on the Data Conversion tab.  

Click the Settings tab to configure the following units and number format settings as appropriate:  

 
o Time Stamp list—Select one of the following timestamp formats for the converted file. If you acquire 

data using an external clock, this list is disabled. Select from the following settings:  
o None—No timestamp information is included in the converted data file.  
o Seconds from Start (ss:ffffff)—The number of seconds after the acquisition began is included in the 

converted file.  
o Time of Day (HH::mm::ss::fff)—The time that the sample was logged is included in the converted file.  
o Date and Time-US (MM/dd/yyyy HH:mm:ss:fff)—The date and time (in the specified format) that the 

sample was logged is included in the converted file.  
o Date and Time (yyyy-MM-dd HH:mm:ss:fff)—The date and time (in the specified format) that the 

sample was logged is included in the converted file.  
o Name textbox—Enter a descriptive name for each channel.  
o Units/Format list—Select the unit for each channel in the converted data file.  

4. Click Convert Data File on the toolbar. 

. 

A progress bar indicates when the file conversion is complete.  
5. Click the Data File Folders location you selected from the Location list, and then click Refresh Location on 

the toolbar to refresh the contents of the folder. 

 

6. Select the converted file on the Available Items pane and click Locate File on Drive to open the folder 
containing the file.  
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The path to the folder is displayed under the Location list.  

 

7. Double-click the .csv file to open it.  

Examples of converted data and event files opened with Microsoft® Excel® are shown below. 

 

The Log Enable Time indicates the time the logger started acquiring data. 

The Data Start Time indicates the time the logger started logging to the SD card. 

The Trigger Time indicates the time the trigger occurred. 

Converted data file in spreadsheet 

 
Converted event file in spreadsheet 

 
 



 

 

Chapter 5 

Adding and removing DAQLog locations and files 
You can manually add and remove the following types of locations: 

 settings file locations by creating a new folder or adding an existing folder  
 raw data file locations by creating a new folder or adding an existing folder  
 memory cards – in an installed card reader or in an attached logger device – as an SD Drive location.  

Removing a location from DAQLog does not remove the folder from the computer, only from DAQLog. 

Adding an SD drive location 
SD drive locations store the following types of files: 

 raw logger data files that you can convert to a text file  
 settings files that you can deploy to remote logger devices  

If your SD card is not displayed in the SD Drives pane after you connect it to the computer, complete the following 
steps to add it to DAQLog: 

1. Click Add SD Drive on the toolbar. 

.  

Right-mouse click method 
You can also right-click SD Drives and select Add…»SD Drive from the pop-up menu.  

The SD Drive Selection dialog box opens.  

 

2. Connect an SD drive to the computer and click Continue.  
If you click Continue without first connecting an SD drive, the No New Storage Devices dialog box opens.  
When the computer detects a connected SD drive, the SD Drive Selection dialog box opens.  

3. Select the drive letter that corresponds to the SD drive, and click OK.  

The SD drive displays in the SD Drives location as a drive letter and volume name (if any). 

To add a volume name using Windows Explorer to differentiate between multiple SD cards and other removable 
media, right click on the drive in Explorer, select Properties, and enter a name in the text box. 
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Removing an SD drive location 
To remove an SD drive location from DAQLog, select the SD drive location and click Remove Location on the 
toolbar.  

 

Right-mouse click method 
You can also remove an SD card location by right-clicking on the SD drive location and select Remove from the 
pop-up menu. 

When you disconnect the SD drive from the computer without using Remove Location (toolbar) or Remove 
(menu), the SD drive location is grayed out until you connect the SD drive again. 

Removing a logger from the DAQLog configuration 
To remove a device from DAQLog, select the device in the Logger Devices area and click Remove Location in the 
DAQLog toolbar. 

 

Right-mouse click method 
You can also remove a device by right-clicking on the device and selecting Remove from the popup menu. 

Adding a settings folder location 
A DAQLog settings location is used to store settings files (.set) for later deployment to logger devices. To add a 
settings location to DAQLog, complete the following steps: 

1. Click Add Settings Folder on the toolbar. 

.  

Right-mouse click method 
You can also right-click Locations and select Add»Settings Folder from the pop-up menu.  

A Browse for Folder dialog box opens.  
2. To create a new settings file location, click Make New Folder, enter a name, and click OK.  

To use an existing folder as a settings file location, select the folder.  
3. Click OK.  

The folder displays in the DAQLog window under Logger Settings Folders. If you add an existing folder, any 
settings files that it contains are also listed in the Available Items pane. 
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Adding a data folder location 
A DAQLog data folder location is typically used as a destination for converted data files and event logs. It can also 
be used as a source for raw data files. To add a data file location to DAQLog, complete the following steps: 

1. Click Add Data Folder in the DAQLog toolbar. 

 

Right-mouse click method 
You can also right-click Locations and select Add»Data Folder.  

A Browse for Folder dialog box opens.  
2. To create a new data file location, click Make New Folder, enter a name, and click OK.  

To use an existing folder as a data file location, select the folder.  
3. Click OK.  

The location appears in the DAQLog window under Data File Folders. If you added an existing folder, any settings 
or data files that it contains are also listed in the Available Items pane. 

You can configure directory structure settings for data file locations that apply to data files converted in that 
location. When you select a data file location, the data file and conversion settings display. By default, data 
converted from a data file location is stored in a subdirectory named using the device serial number and the date the 
file was logged. The default format is \xxxxxxxxxxxx\yyyy-mm-dd, where xxxxxxxxxxxx is the serial number 
and yyyy-mm-dd is the year, month, and day when the log was started. Refer to Configuring converted file storage 
settings for more information. 

Removing a settings folder location or a data folder location 
To remove either a settings folder or data folder location from the DAQLog window, select the folder to remove and 
click Remove Location in the DAQLog toolbar. 

  

Removing a folder location from DAQLog does not delete the folder from the computer. 

Right-mouse click method 
You can also right-click on the location folder and select Remove. The location is removed from the DAQLog 
window. 

Deleting a settings or data file 
To delete one or more settings files (.set) or data files (.dat, .csv, .evt), select the files in the Available Items 
pane and click Delete on the toolbar. 

 

Keyboard method 
You can also select the file(s) and press <Delete> to delete the file(s). 

Files are deleted from the selected location (the folder on your computer, the SD Drive, or the network folder) and 
are removed from the Available Items pane on the DAQLog window. 
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Locating a file 
To locate a file, hover your mouse cursor over a settings location or data location to display a tool tip that lists the 
path to the folder. You can also use DAQLog to open a settings file location or data file location in Windows 
Explorer. 

To open a location in Windows Explorer, select the location or file and click Locate File on Drive in the DAQLog 
toolbar. 
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